Daylight Visualizer 2

User guide
# CONTENTS

INTRODUCTION ............................................................................................................. 4

STUDY ON PROGRAM ACCURACY ................................................................................. 5

1. USER INTERFACE ........................................................................................................ 6
   1.1 File menu .................................................................................................................. 6
      1.1.1 Project properties .............................................................................................. 6
   1.2 Edit menu .................................................................................................................. 7
      1.2.1 Preferences ........................................................................................................... 8
   1.3 Help menu .................................................................................................................. 9
      1.3.1 FAQ and tutorials ............................................................................................... 9
      1.3.2 Shortcuts ............................................................................................................. 9
   1.4 Progress Bar .............................................................................................................10
   1.5 Viewport ...................................................................................................................11
      1.5.1 Edit/Plan view ....................................................................................................11
      1.5.2 Section view ........................................................................................................12
      1.5.3 3D view ..............................................................................................................12
      1.5.4 Toolbar ..............................................................................................................13
   1.6 Input area .................................................................................................................15
   1.7 Guidance text ..........................................................................................................16

2. 3D-MODELER .............................................................................................................17
   2.1 Floor/Walls ............................................................................................................18
      2.1.1 Outer walls .......................................................................................................18
      2.1.2 Inner walls .......................................................................................................19
      2.1.3 Custom object ...................................................................................................19
   2.2 Roof/Ceiling ...........................................................................................................20
      2.2.1 Flat ..................................................................................................................20
      2.2.2 One slope .........................................................................................................20
      2.2.3 Two slopes .......................................................................................................21
   2.3 Window/Doors .......................................................................................................23
      2.3.1 Roof product ....................................................................................................23
      2.3.2 Facade products ...............................................................................................25
      2.3.3 Inner wall openings .........................................................................................26
   2.4 Surfaces ...................................................................................................................27
      2.4.1 User defined surfaces ......................................................................................27
      2.4.2 User defined glass materials ............................................................................28
   2.5 Furniture ................................................................................................................29
2.6 Location ................................................................................................................................. 31
2.7 Camera .................................................................................................................................. 32
  2.7.1 Plan view camera ............................................................................................................... 32
  2.7.2 Cross section camera ....................................................................................................... 33
  2.7.3 Perspective camera ......................................................................................................... 34
2.8 Render .................................................................................................................................... 35
  2.8.1 Still image ....................................................................................................................... 35
  2.8.2 Annual overview ............................................................................................................ 36
  2.8.3 Animation ....................................................................................................................... 36
3. 3D-IMPORTER .......................................................................................................................... 38
  3.1 How to prepare a 3D model for import .................................................................................. 39
    3.1.1 Sketch-Up ....................................................................................................................... 39
    3.1.2 AutoCAD ....................................................................................................................... 39
    3.1.3 OBJ format .................................................................................................................... 39
  3.2 Scale/Units ............................................................................................................................ 40
  3.3 Surfaces .................................................................................................................................. 41
    3.3.1 User defined surfaces .................................................................................................... 42
    3.3.2 Glass materials ............................................................................................................. 43
  3.4 Location .................................................................................................................................. 44
  3.5 Camera .................................................................................................................................... 45
    3.5.1 Plan view camera ........................................................................................................... 45
    3.5.2 Cross section camera .................................................................................................... 46
    3.5.3 Perspective camera ....................................................................................................... 47
  3.6 Render .................................................................................................................................... 48
    3.6.1 Still image ....................................................................................................................... 48
    3.6.2 Annual overview ............................................................................................................ 49
    3.6.3 Animation ....................................................................................................................... 49
4. OUTPUT VIEWER ...................................................................................................................... 51
5. ANNEX A: RENDER TYPE ......................................................................................................... 53
6. REFERENCES ............................................................................................................................. 54
INTRODUCTION
VELUX Daylight Visualizer 2 is a simple tool for daylighting design and analysis. It is intended to promote the use of daylight in buildings and to aid professionals by predicting and documenting daylight levels and appearance of a space prior to realization of the building design.

The Daylight Visualizer intuitive modeling tool permit quick generation of 3D models in which roof and facade windows are freely inserted. The program also permits users to import 3D models generated by CAD programs in order to facilitate a good workflow and provide flexibility to the model geometry.

The simulation output includes: luminance, illuminance and daylight factors. Optional is animation of the daylight conditions over a period.

For more information about the program, please visit http://viz.velux.com

This document has been created to guide the reader in using the VELUX Daylight Visualizer 2. In the process the reader is introduced to the program user interface and guided in using the modeler and the importer to set up a model for simulation.
STUDY ON PROGRAM ACCURACY

VELUX Daylight Visualizer 2 calculations have been validated against CIE 171:2006, Test Cases to Assess the Accuracy of Lighting Computer Programs. The evaluation was performed in collaboration with ENTPE, l'Ecole Nationale des Travaux Publics de l'Etat in France.

The program proved to be accurate in its simulations showing a maximal error lower than 5.13 % and an average error lower than 1.29 %.

The report from the validation study and more information are available at
1. USER INTERFACE

1.1 FILE MENU

From the File menu it is possible to save and open projects, make new projects or import 3D-models from another CAD program. The file menu also contains Project properties in which it is possible to get information about the model.

![Figure 1 Program user interface.](image)

1.1.1 PROJECT PROPERTIES

Information about the model location, surface properties, floor area and total window area is stored in File → Project properties, and is available for print.

The surface properties include roughness, specularity, reflectance and the corresponding RGB (red, green, blue) values. For glass materials RGB values and transmittance are listed.

Note that the 3D-modeler application also has a Products list containing information about window products used in the model and their numbers.
In addition to standard Copy and Paste options, the Edit menu provides Grid spacing and Preferences. The grid spacing controls the distance between gridlines and cannot be less than 100 mm or more than 5,000 mm. Note that the Copy, Paste and Grid spacing commands are not usable when the model importer module is used.
1.2.1 PREFERENCES

In the Preferences menu, find the option to set the program language and select which CIE skies will be available for simulation. Go to Edit → Preferences...

Figure 5 Project preferences.

Language

The program language is by default set to English, but it is possible to change this in the drop-down list. At the moment available languages are: English, French, German, Italian and Spanish. Changing the language will only take effect when the program is restarted.

CIE standard general sky

The sky conditions are modelled according to CIE S 011/E:2003 Spatial Distribution of Daylight – CIE Standard General Sky [1], that “lists a set of luminance distributions, which model the sky under a wide range of conditions, from the heavily overcast sky to cloudless weather”. The list of CIE skies consists of 15 different situations allowing the user to fit the weather conditions to a given situation. For more information about the skies, see the standard.

CIE Standard Overcast Sky, the first sky condition on the list, is used when calculating the Daylight Factor and is one of the default active skies for simulation. To enable more skies mark their check boxes.
1.3 HELP MENU
Find information about the program, get answers to frequently asked questions, check for program updates or get guidance on how to use the program with animated tutorials.

<table>
<thead>
<tr>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online tutorials</td>
</tr>
<tr>
<td>Online FAQ</td>
</tr>
<tr>
<td>Shortcuts</td>
</tr>
<tr>
<td>Check for update</td>
</tr>
<tr>
<td>☑ Enable auto update</td>
</tr>
<tr>
<td>About…</td>
</tr>
</tbody>
</table>

Figure 6 Help menu.

1.3.1 FAQ AND TUTORIALS
The help menu has a link to an online FAQ where the user can get answers to frequently asked questions about the program functionalities. It is also possible to get personalized support via a contact form online.

Online tutorials are also accessible helping the user to start using the VELUX Daylight Visualizer. The user is guided step by step through animated tutorials showing the program features and functionalities.

1.3.2 SHORTCUTS
The following is a list of keyboard and mouse shortcuts available in the program.

**General:**

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>New project</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open project</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Import model</td>
<td>Ctrl+I</td>
</tr>
<tr>
<td>Save project</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Exit</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Grid spacing</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>About</td>
<td>F1</td>
</tr>
<tr>
<td>Preferences</td>
<td>Ctrl+P</td>
</tr>
</tbody>
</table>

**View port:**

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pan</td>
<td>L+R mouse buttons</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Mouse wheel (scroll down)</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Mouse wheel (scroll up)</td>
</tr>
<tr>
<td>Fit</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Measure</td>
<td>Ctrl+M</td>
</tr>
</tbody>
</table>
1.4 PROGRESS BAR

The Progress Bar divides the simulation process into individual steps each guiding the user in setting up a model for simulation. The modeler and the importer have different progress bars due to their respective functionalities, see Figure 7 and Figure 8.

The contents of the individual progress bars are introduced in section 2. 3D-MODELER and 3. 3D-IMPORTER.

Figure 7 The progress bar in the 3D-modeler, marked by a red circle. Set all properties in a step before moving on. The blue triangle indicates the next step.
1.5 VIEWPORT

To represent the model there are three different views: Edit/Plan, Section and 3D. The viewports are illustrated in Figure 9.

1.5.1 EDIT/PLAN VIEW

In the 3D-modeler the Edit view is a horizontal section of the model. It is used in the process of building the geometry and inserting products in combination with modifying settings.

In the importer the Edit view area is called Plan view. The plan is used in the progress to modify settings and to get an overview of the model.

The vertical and the horizontal blue lines in the Edit/Plan view are cutting lines that define the Section view. Moving any of them will move the location of the cross section accordingly.
1.5.2 SECTION VIEW
The section view is a vertical cut through the model. The location of the cut is defined by the two section lines in the Edit/Plan view, as described before. The last selected section line will set the view direction.

Likewise, the horizontal blue line in the Section view controls the plan cutting height. Thus, moving it by the mouse will move the Plan view accordingly.

1.5.3 3D VIEW
This view gives a 3D representation of the model in real-time. It is possible to rotate the model by mouse manipulation: Click and hold the left mouse button on the picture and move the mouse.

Figure 9 Program viewport includes an Edit/Plan view, 3D view and a Section view
1.5.4 TOOLBAR
Each viewport has a set of tools located in their upper left corner. All have the fit and zoom functions. In addition the Section and Edit/Plan viewports have a pan and a ruler function.

Pan
The pan function is illustrated by a hand, located at the left side of the toolbar. Click on the pan icon and use the left mouse button to move the model inside the viewport. Holding down both mouse buttons at the same time will automatically enable the pan functionality.

Zoom
The magnifying glasses provide zoom in and zoom out functions and are available for all viewports. It is also possible to zoom in and out by scrolling the mouse wheel back and forth, respectively. A third possibility is to hold down the right mouse button and drag the mouse left or right.
Fit

The fit function is illustrated by a two-way arrow. Clicking it will adjust the zoom so that the complete model is visible and centre it. Use Ctrl+F as shortcut.

Measure

The ruler in the toolbar is used to measure vertical and horizontal distances. It cannot measure diagonally. Use Ctrl+M as shortcut.

Shaded mode / wireframe

The 3D view in the modeling module has a shaded and a wireframe mode to present the model. If a model is imported from another CAD program, the model is presented in a shaded mode with no other options available. See examples in Figure 11 and Figure 12.

Figure 11 Example of shaded mode.

Figure 12 Example of wireframe mode.
1.6 INPUT AREA

The section below the Edit/Plan view is intended for definition of the model properties. Browsing through the Progress bar will change the options in the Input area according to the subject. For instance, in the Floor/Walls step the Input area includes variables for wall properties.

<table>
<thead>
<tr>
<th>Wall properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Outer walls]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Wall length (mm):</th>
<th>Wall height (mm):</th>
<th>Wall thickness (mm):</th>
</tr>
</thead>
<tbody>
<tr>
<td>500</td>
<td>2500</td>
<td>300</td>
</tr>
</tbody>
</table>

Figure 13 Input options for Outer walls under the Floor/Walls tab in the modeler module

The input area can be divided into two sections, first row and second row. In the first row the user chooses what to specify and in the second row variables control the properties of that selection. For instance, in Figure 13 Outer walls is chosen in the first row, providing options for outer wall dimensions in the second row. But clicking the “Inner walls” button provides options for inner wall dimensions, see Figure 14.

<table>
<thead>
<tr>
<th>Wall properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Outer walls]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Wall length (mm):</th>
<th>Wall height (mm):</th>
<th>Wall thickness (mm):</th>
</tr>
</thead>
<tbody>
<tr>
<td>500</td>
<td>2500</td>
<td>150</td>
</tr>
</tbody>
</table>

Figure 14 Input options for Inner walls under the Floor/Walls tab

Text boxes like those in the example can be modified either by typing numerical values directly in them or by using the more or less buttons just next to the boxes.
1.7 GUIDANCE TEXT
The yellow box located in the bottom right corner provides the user with guidance on how to set up a model. As the tab is changed, the guidance will change accordingly to match the situation. For example in Figure 15 guidance is given regarding the setup of a camera.

Figure 15 Guidance given in the Camera configuration provides useful step by step information on how to set up the model for simulation.
2. **3D-MODELER**

The 3D-modeler is a program module permitting the user to build simple 3D models, insert windows, objects, furniture and set properties required to make simulations for daylight analysis.

The module is started by clicking on *New project* on the start-up screen or in the *File* menu. Select a *Grid spacing* in the pop-up window. Then follow every step in the progress bar starting with Floor/Walls.

![Figure 16 VELUX Daylight Visualizer start-up window.](image)
2.1 FLOOR/WALLS
First step deals with defining the geometry of the model and contains options for outer walls, inner walls and custom objects. Until the outer walls have been defined other properties are inaccessible. Inner walls and custom objects, which are also modified in this step, are optional for the model and not needed for simulation.

2.1.1 OUTER WALLS
To draw the outer walls, left-click in the Edit view where the wall should start. Then move the mouse to the location where the wall ends and click left mouse button again. The next wall will start where the previous wall ended. Continue until the floor plan is closed in by outer walls. This will create the floor.

![Figure 17 Drawing the floor and outer walls.](image)

When the floor plan is closed in, it is possible to adjust the wall dimensions. To edit the length of a wall either select it by clicking on it and typing the length in the Input area or drag the wall in the Edit view. All walls have identical height and thickness that can be edited in the respective text boxes.

It is only possible to draw horizontal and vertical walls in the 3D-modeler. More complex models can be imported from other CAD programs; more information about this in section 3. 3D-IMPORTER.
2.1.2 INNER WALLS
Internal partitions are made by selecting the *Inner walls* button. Then in the *Edit view* left-click on the wall starting point and left-click again where the wall should end.

Inner walls can be moved around by mouse manipulation in the *Edit view* as long as they remain on the inside of the outer walls. The length and thickness can be modified in the text boxes, but the height follows the ceiling height.

2.1.3 CUSTOM OBJECT
The custom object can be utilized for different purposes, being outside and/or internal obstructions, such as creating details to the room, giving a sense of dimensions, etc.

To create a custom object, look at it as a rectangle at floor level being extruded upward. First left click on the grid in the *Edit view*. This will create the centre point of the rectangle. Then move the mouse to another point on the grid to define the distance from the centre to the corner positions. Notice that the corners are drawn symmetrically – from where the mouse was clicked – about the horizontal and vertical axes going through the centre point. The rectangle is then extruded 1,000 mm from the floor by default.

The dimensions of the object, height above ground and rotation, can be controlled in the *Input area*. It is also possible to rotate a selected object by dragging the green dot next to it, see Figure 18.

![Figure 18 Custom object options. The object can be rotated by dragging the green dot next to it, marked by a red circle.](image)
2.2 ROOF/CEILING
In the second step the roof and ceiling are defined, closing the model geometry. In the Input area there are three different roof types to choose from: a flat roof, a one slope roof and a two slopes roof.

2.2.1 FLAT
To model a flat roof, click the Flat button. A flat ceiling is then created at the same height as the outer walls with a default roof thickness of 400 mm. The roof thickness can be adjusted by numerical inputs in the text box.

Optionally define an overhang in the Input area by its projection from the outer walls (Dimension) and height above floor.

![Flat roof options. The overhang is illustrated by the punctuated lines](image)

2.2.2 ONE SLOPE
To draw a roof with a single slope click the One slope button and select the wall from which the roof will be raised. The roof will then rise to the opposing wall, see Figure 20. Next, adjust the roof thickness in the text box.
The slope of the roof is set in the *Roof pitch* text box and is by default set to 30°. An optional overhang is defined as described in section 2.2.1 Flat.

Choose between two options for ceilings: *Open* and *Flat*. By default the *Open* ceiling is selected. This models the ceiling parallel to the roof. Selecting the *Flat* option, the ceiling becomes horizontal. The ceiling height is by default set to 2,500 mm, but can be adjusted by numerical inputs in the text box.

![Figure 20](image)

**Figure 20** Roof with a single slope. The roof rises from the selected wall (marked with green colour in the *Edit view*).

### 2.2.3 TWO SLOPES

This selection is for common roof designs with a ridge and a slope on each side of it. A two slopes roof is created by drawing the ridge. To do this, left-click on a wall in the *Edit view* where the ridge should begin. Then left-click on the opposing wall to end the ridge. The approach is illustrated on Figure 21. Optionally the red centre lines can be used as guidance when drawing the ridge to obtain a symmetrical result.

Adjust the roof thickness and the roof pitch. If the *median height* (ridge height) is adjusted, the wall height will be adjusted accordingly to fit the roof pitch. Changing roof pitch will adjust the median height. An optional overhang is defined as described previously for the flat roof in section 2.2.1 Flat.

Next, choose between ceiling options. The *Open* ceiling option button is by default selected and sets the ceiling parallel to the roof. Selecting the *Flat* option button, the ceiling becomes horizontal. The ceiling height is by default set to 2,500 mm, but can be adjusted by numerical inputs in the text box.
Figure 21 Two slopes roof. The ridge is drawn between points 1 and 2, marked by the red circles.

The ridge can be drawn from more than two points, giving the possibility of changing the direction of the ridge. An example is given in Figure 22.

Figure 22 Illustration of how to change the direction of the ridge. The numbers next to the red circles indicate the order in which the roof was drawn.
2.3 WINDOWS/DOORS

In this step three different kinds of openings can be added to the model: Roof product, Facade product and Inner wall openings. Proceeding in the progress bar is inaccessible until at least one window has been added.

When an opening has been inserted, it can be found in the Objects in model list box. To edit an object double click on it in the list box or in the Edit view, see Figure 23.

Doors and windows can only have rectangular shapes. If more complex shapes are important to the project, it is recommended to use the 3D-importer.

![Figure 23 Inserting windows and doors. Objects used in the model are listed in the left side of the Input area. Selecting a product will list the dimensions and location in the middle and the properties to the right in the Input area.](image)

2.3.1 ROOF PRODUCT

To insert a roof window or a skylight click on Roof product. This will call for a list of pre-defined VELUX roof window products that can be used in the model, see Figure 24.
The left column in the products list provides the user with 6 layouts. Select appropriate layout and optional if it should be combined with other windows. Faded layouts mean that they are not applicable for the specific roof design. This could be due to the slope of the roof or that a Flat ceiling is used or not. Requirements are listed below:

- **Flat roof solutions:** Slope 0°-15°
- **Light shaft:** Slope 15°-45°, requires Flat ceiling
- **Remaining windows:** Slope 15°-89°, requires Open ceiling

In the right column the product description gives details about feasible roof pitch ranges and operation of the window. Select window dimensions from the drop-down list, choose lining properties and then click Ok.

The chosen window will now appear in the plan view as a red or green rectangle depending on the position of the window. If the position is invalid it is coloured red. Valid location of the window is illustrated by a green colour (blue when deselected).
Moving the window is done by dragging it in place with the mouse or by using numerical inputs in the text boxes to define the distances from the opposing bottom wall and the opposing side wall (to the left of the window). Eventually verify the installation height in the Section view.

To insert additional windows click the product button again and repeat the procedure, or more easily use copy and paste on inserted window products. Then edit the copied products as needed.

2.3.2 FACADE PRODUCTS
Insert a window or a door in the facade by clicking Facade product. In the emerged products list select appropriate window or door layout in the left column, see Figure 25.

![Figure 25 Facade products list. Layouts and combinations are listed in the left column and product description, dimensions and lining properties are listed in the right column.](image-url)
In the right column window dimensions and lining properties can be adjusted by numerical inputs in the text boxes. Press Ok to insert the door/window in the model.

The location of doors and facade windows can be set in the Input area, but moving them from one outer wall to another is done by mouse manipulation in the Edit view. Invalid positioning will be marked by red colour. For windows, the height above floor is also set in the Input area and is set to 900 mm by default. Doors are locked to ground level.

2.3.3 INNER WALL OPENINGS
Creating holes in internal partitions is done by selecting inner wall opening. The hole will be created in one of the inner walls and can be moved around by mouse manipulation. The dimensions and height above floor can be adjusted in the Input area, see Figure 26.

Figure 26 Inner wall openings. Dimension and location of hole can be edited in the Input area when the hole is selected.
2.4 SURFACES
In this step, surface properties are defined for the different building elements in the model.

To edit the surface properties choose the building element in the first row of the Input area, in Figure 27 the Roof product button has been clicked. Then, in the second row, pick an element from the list. Note that only Roof product and Facade product have more than one element to choose from.

When the element is chosen, pick a surface from the Surface list. A preview and properties of the surface are listed in the right side of the Input area. In case that the pre-defined surface options do not satisfy the need, custom surfaces can be made by clicking the User defined... button.

2.4.1 USER DEFINED SURFACES
Click the User defined... button to create a surface with custom properties. In the emerged window the reflectance is set by adjusting the RGB-values (Red, Green and Blue), see Figure 28. To change any of the RGB-values use the respective slider or text box. The valid range is between 0 and 1. Additionally the Floor element has a Texture option that enables the use of JPG-files on the surface. The Use checkbox should be unchecked if textures are not used.
The roughness and specularity can also be adjusted by moving the respective slider or by typing values in the text boxes next to their slider. Both properties range from 0 to 1.

Figure 28 User defined surface properties. Textures (red circle) are available only for the floor element.

2.4.2 USER DEFINED GLASS MATERIALS
Clicking the User defined... button when a Pane is selected in the Element list will call for a window where it is possible to edit the light transmittance, see Figure 29. The light transmittance can be entered in the text box or adjusted by use of the slider.

The visual transmittance ranges from 0 to 1, where the pane is opaque at 0 and completely transparent at a visual transmittance of 1.

Figure 29 Visual transmittance of a custom pane
2.5 FURNITURE
The modeler has a range of furniture that can be used to create a more detailed environment for the simulation and give a sense of scale to the room.

Click the Select furniture button to open a list of products, see Figure 30. In the left column choose between home, office and school furniture. In the right column a preview of the selected furniture and colour options are given. Press Ok to insert the object.

![Figure 30 Furniture products list](image)

Inserted furniture can be moved around by mouse manipulation and rotated in the Rotate selected text box in the Input area, see Figure 31. Rotation is also possible by left clicking the green dot next to the furniture and moving it around.
Figure 31 Example of furniture in a model. Select a piece of furniture and move it by mouse manipulation. The furniture can be rotated by dragging the green dot next to the furniture (marked by a read circle) or by typing the rotation in the text box.
2.6 LOCATION
The location setting defines the position of the sun at any time chosen to be simulated. In the Location drop-down list choose from pre-defined cities or make a custom location by specifying its longitude and latitude.

The orientation is set with the light blue arrow in the Edit view, illustrating the north orientation, and can be modified either by mouse manipulation or by typing it in the Degrees text box turning it clockwise.

Figure 32 Choosing location and orientation of the model
2.7 CAMERA

The camera settings are used to define the view to render in simulations. Three options are available: Plan view, Cross section and Perspective. Clicking one of them will activate it and it will be used for rendering.

2.7.1 PLAN VIEW CAMERA

This camera view is used to simulate daylight conditions at a horizontal plane. Define the camera view height by moving the cutting line in the Section view or type numerical inputs in the View height text box.

Use the Set area button to define the area of investigation. This will create a white rectangle surrounded by a grey area in the Edit view. The camera will simulate daylight conditions for the white area.

The area can be modified by left-clicking and dragging any borderline in the Edit view, see Figure 33.

Figure 33 Plan view camera settings. Drag the border lines in their centre dots to manipulate the output area (marked by red circles in the Edit view).
2.7.2 CROSS SECTION CAMERA
Selecting Cross section camera will make a vertical section through the model and use that as camera view. The location of the cross section is controlled by the cutting lines in the Edit view. The camera location can be seen in the Section view.

The view direction is modified by moving the cutting lines: Moving a cutting line in one direction will set the camera view in the same direction. The arrow attached to the selected cutting line also indicates the view direction.

Figure 34 Cross section camera set-up. The Section line in Edit view controls the Cross section view direction and is indicated by a blue arrow (highlighted by the red circle).
2.7.3 PERSPECTIVE CAMERA

The Perspective camera permits visualization of the daylight conditions from different heights and angles in the room.

The camera can be moved around by mouse manipulation in the Edit view and the height changed in the Section view. Clicking the left mouse button in the Edit view or in the Section view will change the rotation or tilt of the camera, respectively. The Rotation, Tilt and Height above ground can also be adjusted in the Input area. Eventually set the Focal length of the camera in the drop-down list.

A preview of the perspective output area is illustrated in the 3D view.

Figure 35 Perspective camera settings. A preview of the output area is illustrated in the 3D view.
2.8 RENDER

The render specifications offer three types of simulation: Still image, Annual overview and Animation. Select the desired type to prepare the simulation.

When the complete model and render settings are set, press the Render button in the Input area to start the simulation. The results are prompted in the Output viewer, see section 4. OUTPUT VIEWER for more information.

![Figure 36 Render settings](image)

2.8.1 STILL IMAGE

This render specification is used to simulate the daylight conditions for a given time of year and day controlled in the Input area. Available dates are each 21\textsuperscript{st} of a month; the time of day can be set freely.

![Figure 37 Still image render specifications.](image)
In the Render type drop-down list choose between Luminance, Illuminance and Daylight factor. Information about render types can be found in ANNEX A: RENDER TYPE.

Next, select the desired Sky condition from the drop-down list. Sky conditions and how to add skies to the list are described in section 1.2.1 Preferences. Note that when choosing Daylight factor as render type the sky is automatically set to CIE Standard Overcast Sky and cannot be changed.

In the Resolution drop-down list choose from pre-defined resolutions or make a custom one, if needed. Then adjust the Render quality by moving the slider. The better quality takes longer time to render.

### 2.8.2 ANNUAL OVERVIEW

Using the Annual overview option in simulation will generate 12 still image outputs, 1 output for the 21st of each month. The dates are fixed, but the time of day can be adjusted in the Input area.

Set the Render type in the drop-down list. Choose between Luminance, Illuminance and Daylight factor. Information about the render types and their use can be found in ANNEX A: RENDER TYPE.

Next, select the desired Sky condition from the drop-down list. Sky conditions and how to add skies to the list are described in section 1.2.1 Preferences. Note that when generating Daylight factor outputs the simulation automatically utilizes the CIE Standard Overcast Sky.

In the Resolution drop-down list choose from pre-defined resolutions or make a custom one, if needed. Then adjust the Render quality by moving the slider. The better quality takes longer time to render.

### 2.8.3 ANIMATION

Selecting Animation, the user can make videos of the daylight conditions for a given period of a day. Choose a date in the Time of year drop-down list and set the period of day in Time range.
Set the Render type in the drop-down list. Choose between Luminance, Illuminance and Daylight factor. Information about the render types and their use can be found in ANNEX A: RENDER TYPE.

Next, select the desired Sky condition from the drop-down list. Sky conditions and how to add skies to the list are described in section 1.2.1 Preferences. Note that when generating Daylight factor outputs the simulation automatically utilizes the CIE Standard Overcast Sky.

In the Resolution drop-down list choose from pre-defined resolutions or make a custom one, if needed. Notice that the pre-defined resolutions are lower in Animation than in Still image and Annual overview. Adjust the Render quality by moving the slider. The better quality takes longer time to render.

Now click the render button. This calls for a save window and a movie settings window, see Figure 40. In the save window choose a name and location for the video result files and press save. Then in the movie settings adjust the Duration of the video and Frame rate. Optionally, modify the Exposure and Compression. Press Ok to start the simulation.
3. **3D-IMPORTER**

The 3D-importer module is a part of the VELUX Daylight Visualizer that allows the user to import 3D models made in other CAD drawing programs. Using the import function allows for more advanced models that yet cannot be modelled in the 3D-modeler. To do this go to *File → Import project*, then locate the file and open it.

Currently supported file types are:

- .OBJ
- .skp
- .dwg/.dxf

![Figure 41 Importing projects](image-url)
3.1 HOW TO PREPARE A 3D MODEL FOR IMPORT

To avoid conflicts when using 3D models from other CAD programs, make sure that the faces are triangulated. Singular lines will not be imported.

Window panes should be modelled as a single layer of polygons, also if using multiple panes.

Special notes on the different formats are listed in the following sections.

3.1.1 SKETCH-UP

Closing 3 or more lines together in Sketch-Up will automatically create triangulated faces. Using the polygon functions and extruding them is also possible.

When the model is built, use the paint bucket function to assign materials to the surfaces. Use the same material on elements with identical surface properties. For instance, all inner walls could share one material while the ceiling had another, the floor a third and window glasses a fourth. This will make it easier to set up the surface properties in section 3.3 Surfaces. Optionally, name the material to distinguish better between elements as the material names are also imported.

Only assign the material to one side of the face as the other side assumes the same settings in the Daylight Visualizer.

3.1.2 AUTOCAD

When creating 3D models in AutoCAD the user has to be aware that lines, polylines and rectangles drawn by the “Rectangle” function will not be imported into the Daylight Visualizer. Valid solutions could be to use the “Region” function on a set of lines, 3D Faces or to create 3D solids.

It is highly recommended to assign several layers to the model, each layer representing a group of building elements. This will be helpful when assigning surface properties in the second step of the simulation; more about this in section 3.3 Surfaces. Optionally, name the layers to distinguish better between elements as the layer names are also imported.

3.1.3 OBJ FORMAT

When exporting the OBJ format, ensure that the materials assigned to the model are also exported. There should be an option in the respective programs to ensure this.
3.2 SCALE/UNITS

After importing a 3D model it is advised to check if the scale is correct as it may differ from project to project. Use the measure tool in the Plan or Section view to make sure that the dimensions are correct. The Units’ drop-down list enables the user to choose from SI units and American units for the measure tool. Use the fit function to zoom in/out on the complete model, if needed.

Should the model be out of scale, it is possible to correct this by using the scale factor.

![Figure 42 Scaling and changing units](image-url)
3.3 SURFACES

In this step, surface properties are defined for the different building elements in the model.

*Elements* are groups of one or more surfaces with the same properties, for instance all walls. They are automatically created when importing the 3D model, but the user needs to make and assign them to the surfaces in the respective modeling tool.

.large\m If planes in SketchUp are assigned the same *material*, they will be grouped in the *Element* list in the Daylight Visualizer with the respective material name and share the same surface properties.

.large\m If planes in AutoCAD are assigned the same *layer*, they will share surface properties in the Daylight Visualizer when the dwg or dxf files are imported. They are listed in the *Element* list box with the layer name used in the CAD program.

To assign surface properties choose the respective building element in the *Element* list box, then select a *Material* and find an appropriate *Surface* in the list box. In the right side of the *Input area* the properties and a preview of the chosen surface are listed. If none of the pre-defined surfaces have appropriate properties use the *User defined...* option.

![Figure 43 Surface properties settings](image)
3.3.1 USER DEFINED SURFACES
Click the User defined... button to create a surface with custom properties. In the emerged window the reflectance is set by adjusting the RGB-values (Red, Green and Blue), see Figure 44. To change any of the RGB-values, use the respective slider or text box. The valid range is between 0 and 1. Using a texture is optional, but if unused the Use check box should be unchecked.

Roughness and specularity can also be adjusted by moving their slider or by numerical inputs in their text boxes.

![Custom surface definition](image)

Figure 44 Custom surface definition. Disable the texture options if this is not used.
3.3.2 GLASS MATERIALS
There are two options as regards translucent surfaces: window glass and solid glass.

Window glass is used to model the behaviour of light passing through a window. Note that windows with more than one pane should be modeled as one layer in the CAD program and in the Daylight Visualizer given a combined light transmittance. Using the user defined option the transmittance is controlled by the RGB values that can be adjusted with the sliders and the text boxes, see Figure 45.

The solid glass option includes IOR (Index Of Refraction) that models the bending of light crossing the interface of a material. It ranges between 1 and 2. If the model includes solid glass, the objects should consist of two layers. If an object only consists of one layer, the Two sided check box should be disabled, see Figure 46.

![Figure 45 Custom window surface settings.](image1)
![Figure 46 Custom solid glass surface settings.](image2)
3.4 LOCATION
The location setting defines the position of the sun at any time chosen to be simulated. In the Location drop-down list choose from pre-defined cities or make a custom location by specifying the longitude and latitude.

The orientation is set with the light blue arrow in the Plan view, illustrating the northward orientation, and can be changed either by mouse manipulation in the Plan view or by numerical inputs in the Degrees text box, turning it clockwise.

Figure 47 Location is chosen in the drop-down list to the left. The blue arrow indicates the northward direction and can be adjusted by mouse manipulation.
3.5 CAMERA

The camera settings are used to define the view to render in simulations. Three options are available: Plan view, Cross section and Perspective. Clicking one of them will activate it and it will be used for rendering.

3.5.1 PLAN VIEW CAMERA

This camera view is used to simulate daylight conditions at a horizontal plane. Define the camera view height by moving the cutting line in the Section view or typing numerical values in the View height text box.

Use the Set area button to define the area of investigation. This will create a white rectangle surrounded by a grey area in the Plan view. The camera will simulate daylight conditions for the white area.

The area can be modified by left-clicking and dragging any borderline in the Plan view, see Figure 48.

Figure 48 Plan view camera settings. The camera area can be modified by dragging any of the borderlines controlled by the dots (marked by red circles).
3.5.2 CROSS SECTION CAMERA
Selecting Cross section camera will make a vertical section through the model and use that as camera view. The location of the cross section is controlled by the cutting lines in the Plan view. The camera location can be seen in the Section view.

The camera view direction is modified by moving the cutting lines: Moving a cutting line in one direction will set the camera view in the same direction. The arrow attached to the selected cutting line indicates the view direction.

Figure 49 Setting up a cross section camera. The camera view direction is illustrated by the arrow attached to the selected cutting line (marked by the red circle).
3.5.3 PERSPECTIVE CAMERA

The *Perspective camera* permits visualization of the daylight conditions from different heights and angles in the room.

The camera can be moved around by mouse manipulation in the *Plan view* and the height changed in the *Section view*. Clicking the left mouse button in the *Plan view* or in the *Section view* will change the rotation or tilt of the camera, respectively. The *Rotation*, *Tilt* and *Height above ground* can also be adjusted in the *Input area*. Eventually set the *Focal length* of the camera in the drop-down list.

A preview of the perspective output is illustrated in the *3D view*.

![Figure 50 Perspective camera view settings](image)

---

**Figure 50 Perspective camera view settings**

<table>
<thead>
<tr>
<th>Rotation</th>
<th>Tilt</th>
<th>Height above ground</th>
<th>Focal length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Degrees</td>
<td>Degrees</td>
<td>m</td>
<td>mm</td>
</tr>
<tr>
<td>316°</td>
<td>26°</td>
<td>2000</td>
<td>22 mm</td>
</tr>
</tbody>
</table>

1. Drag the camera to a valid position
2. Rotate the camera by clicking around the camera
3. Adjust camera tilt
4. Adjust camera height
5. Adjust focal length
3.6 RENDER

The render specifications offer three types of simulation: Still image, Annual overview and Animation. Select the desired type to prepare the simulation.

When the complete model and render settings are set, press the Render button in the Input area to start the simulation. The results are prompted in the Output viewer, see section 4. OUTPUT VIEWER for more information.

![Render specifications](image)

3.6.1 STILL IMAGE

This render specification is used to simulate the daylight conditions for a given time of year and day controlled in the Input area. Available dates are the 21st of each month; the time of day can be set freely.

![Still image render specifications](image)
In the Render type drop-down list choose between Luminance, Illuminance and Daylight factor. Information about render types can be found in ANNEX A: RENDER TYPE.

Next, select the desired Sky condition from the drop-down list. Sky conditions and how to add skies are described in section 1.2.1 Preferences. Note that when choosing Daylight factor as render type, the sky is automatically set to CIE Standard Overcast Sky and cannot be changed.

In the Resolution drop-down list choose from pre-defined resolutions or make a custom one, if needed. Then adjust the Render quality by moving the slider. The better quality takes longer time to render.

3.6.2 ANNUAL OVERVIEW

Using the Annual overview option in simulation will generate 12 still image outputs, 1 output for the 21st of each month. The dates are fixed, but the time of day can be adjusted in the Input area.

![Figure 53 Annual overview render specifications.](image)

Set the Render type in the drop-down list. Choose between Luminance, Illuminance and Daylight factor. Information about the render types and their use can be found in ANNEX A: RENDER TYPE.

Next, select the desired Sky condition from the drop-down list. Sky conditions and how to add skies are described in section 1.2.1 Preferences. Note that when generating Daylight factor outputs the simulation automatically utilizes the CIE Standard Overcast Sky.

In the Resolution drop-down list choose from pre-defined resolutions or make a custom one, if needed. Then adjust the Render quality by moving the slider. The better quality takes longer time to render.

3.6.3 ANIMATION

Selecting Animation the user can make videos of the daylight conditions in a given period of a day. Choose a date in the Time of year drop-down list and set the period of day in Time range.
Set the **Render type** in the drop-down list. Choose between **Luminance**, **Illuminance** and **Daylight factor**. Information about the render types and their use can be found in ANNEX A: RENDER TYPE.

Next, select the desired **Sky condition** from the drop-down list. Sky conditions and how to add skies are described in section 1.2.1 Preferences. Note that when generating **Daylight factor** outputs the simulation automatically utilizes the **CIE Standard Overcast Sky**.

In the **Resolution** drop-down list choose from pre-defined resolutions or make a custom one, if needed. Notice that the pre-defined resolutions are lower in **Animation** than in **Still image** and **Annual overview**. Adjust the **Render quality** by moving the slider. The better quality takes longer time to render.

Now click the render button. This calls for a save window and a movie settings window, see Figure 55. In the save window choose a name and location for the video result files and press save. Then in the movie settings adjust the **Duration** of the video and **Frame rate**. Optionally, modify the **Exposure** and **Compression**. Press **Ok** to start the simulation.
4. OUTPUT VIEWER

The Output viewer appears when the rendering is started. In the black area of the window it generates a graphical output that represents the results. The white area below presents simulation information including the location, time of day, orientation and the weather conditions; it also gives options for the representation, see Figure 56.

In the Input area choose between False colour and ISO contour lines to present the daylight conditions of the environment. Then adjust the minimum and maximum values in the text box below the respective presentation, see Figure 57 and Figure 58.

It is possible to get information about the daylight conditions at a specific location by right-clicking on the graphical output. Using the Grid values option will apply a mesh of values; see Figure 59 and Figure 60.

An average value of a user specified area is available for the render types Illuminance and Daylight factor. To get this, click and hold the left mouse button on the graphical output and drag the area with the mouse.
Optionally, use the Exposure slider to adjust the brightness of the graphical output. Click on the Save button to store the image on a hard drive or click the Print button to send it to a printer. Note that the images are not saved when using the save function in the File menu.
5. ANNEX A: RENDER TYPE

Luminance

Luminance is the measure of the amount of light output or reflected off a surface and is expressed in cd/m\(^2\). It is the measure of light used to evaluate visual comfort and glare in the interior.

The human eye and the camera respond only to luminance, not to illuminance (light incident on a surface). As a result, the luminance setting provides photo realistic images as output.

The distribution of luminance is a measure of how lighting varies from point to point across a plane or surface. For good visibility, some degree of uniformity across the task plane is desirable. Too high or too low contrasts may cause discomfort and tiredness. For offices ANSI/IESNA RP-1 sets guidelines for maximum contrast ratios on surfaces.

Illuminance

Illuminance is a measure of the amount of light received on a surface. It is an absolute value typically measured in lux (lm/m\(^2\)) that varies with the time of day and the weather conditions. Due to the variation of intensity, it should be evaluated together with the Daylight factor.

Currently, illuminance is the measure of light used by most performance indicators to determine daylight availability in the interior. Thus, guidelines set recommended setpoints of minimum lux levels for occupants to perform certain tasks properly. When the recommended lux levels cannot be achieved by daylight alone, artificial lighting has to compensate for the lack of daylight.

Daylight factor

The Daylight factor is a measure of internal illuminance relative to external unobstructed illuminance under standard CIE overcast sky conditions and is expressed as a percentage [2]. It is a common measure, which permits determination of the availability of daylight in a room.

The Daylight factor is usually measured at a working plane where visual tasks are likely to take place, often 0.7 - 0.8 m above the floor, corresponding to an office- or school desk. The higher DF the more daylight is available in the room. An average DF < 2% generally makes a room look dull and artificial lighting is likely to be needed, whereas an interior will look substantially daylit when the average DF > 5% and artificial lighting will most likely not be needed during daytime [2].


6. REFERENCES
